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(Hi there! Want to snag this for you o you can take notes? File >Make a copy!)

0r HUW | Learneﬂ
to Stop Worrying
and Love the

Library with__ ,
my Phone -

A

@Gwyneth JoReS™ Twitter
@TheDaringLibrarian on 1G

Do you have a fear of missing out? That's FOMO. Use your phone to
connect library programs and positive points of light with students, parents,



and the community. Communicate with students about new materials, book
drop life, interactions with books, literacy programs, reading promotions,
library offers, photo engagement challenges, and special events.
Collaboration and connections are what defines an exemplary school
library program.

Instagram is where our students are, and it can be a one stop shop while
at the same time providing a positive and professional modeling of Social
Media usage. However, the same techniques librarians use to build a solid
Instagram account can easily transfer to communicate and collaborate in a
variety of different ways. Bring water. No Fluoride. No FOMO.

“Last year’s popular Summer Institute speaker, Gwyneth Jones, the Daring Librarian, is
returning to SLIM via her FREE webinar on Wednesday, October 9 at 7 pm, CDT.
Please, mark on your calendar now and join the webinar at:”

ZOOM LINK for Webinar!
KASL web site

PIEASE: GO TO: File >Make a Copy

FOMO: oHow | LeArNED To STop
Worrvune
AND [oVE THE INSTAGTRAM

SESSION NOTE-TAKING WORKSHEET

Write Your Profile: 150 characters Instagram Profile:

Or use Tools > Word Count Practice writing your profile below. Make it
Here's mine: fun, snappy, & connect to your Library
Future Ready Teacher Librarian. Mover, passions.

Shaker, International Keynote Speaker, &
Google Certified. Geek. Ridiculously

Humble. Twitter: [@GwynethJones
= 148 Characters

Book Promotion Ideas Bookface Ideas

Book Field Trip Promo Ideas Library Display Ideas

Here’s a handy Note-Taking Worksheet
for this Session - Please go to FILE > Make a copy



https://emporiastate.zoom.us/j/943050793
http://www.ksschoollibrarians.org/
https://docs.google.com/document/d/1IB563oWDkUyAtTjbEHkjl5ABJ4_mA3YmsKCHV-S-eGg/edit?usp=sharing
https://docs.google.com/document/d/1IB563oWDkUyAtTjbEHkjl5ABJ4_mA3YmsKCHV-S-eGg/edit?usp=sharing

Instagram Video Montage

Instagram Video Montage

by @Gwynethlones - Twitter @TheDaringLibrarian - Instagram

P »l o) 0:02/519 v

YouTube Instagram (& Vine!) Video Montage

Basics & Background

Say Yes! To a School Instagram!

**NEW BLOG POST**10 Easy Instagram Photo Book Challenge
How to use Instagram for schools

Vimsy - How | Learned to Stop Worrying and Love Instagram Stories

9 Ways To Use Instagram In Your Library (This was written for public libraries, but many
of the ideas are totally transferable to schools)

Inspiration: The fear of Missing Out: Or How | Learned to Stop Worrying and
Love . (warning: NSMS language)

5 Steps to Creating an Instagram Profile That People Can't Help But Follow
4 Ways To Increase Your School's Social Media Engagement

New Tools to Limit Bullying and Spread Kindness on Instagram

Instagram Debuts New Features to Fight Bullying

How will Instagram’s new anti-bullying features actually work?
Instagram is using Al to detect bullying in photos and captions



https://www.youtube.com/watch?v=qxnouJLqtoM&feature=youtu.be
https://youtu.be/qxnouJLqtoM
https://www.thedaringlibrarian.com/2015/03/say-yes-to-school-instagram.html
https://www.thedaringlibrarian.com/2019/09/10-easy-instagram-photo-book-challenge.html
https://www.schoolwebmasters.com/Blog_Articles?entityid=375224
https://vimsy.co/blog/how-i-learned-to-stop-worrying-and-love-instagram-stories
http://www.rivistas.com/12-must-follow-library-instagram-accounts/
https://www.youtube.com/watch?v=F11izUK9a4c
https://www.youtube.com/watch?v=F11izUK9a4c
https://www.themuse.com/advice/5-steps-to-creating-an-instagram-profile-that-people-cant-help-but-follow
https://www.youtube.com/watch?v=F11izUK9a4c
https://www.finalsite.com/blog/p/~board/b/post/4-ways-to-increase-your-schools-social-media-engagement
https://instagram-press.com/blog/2018/10/09/new-tools-to-limit-bullying-and-spread-kindness-on-instagram/
https://fortune.com/2019/07/08/instagram-anti-bullying-features/
https://www.vox.com/the-goods/2019/7/9/20687697/instagram-anti-bullying-restrict-shadow-ban-comment-filter
https://www.theverge.com/2018/10/9/17954658/instagram-ai-machine-learning-detect-filter-bullying-comments-captions-photos

IG Holiday Highlights & More! Example how to share to the Community & World via
blog!

24 Social Media Shortcuts FREE PRINTABLE! This is a super handy
checklist for anyone starting out with Social Media - maybe nice to see if
there’s anything you can tweak or to give out to your staff in a professional
development session.

Social Media Shortcuts: At-A-Glance Tips for Educators from The Daring
Librarian Experience -- Give me just the direct Printable already

Kinda off topic but hilarious! Here’s an Annoying New Instagram Trend: Throwing
Yourself on a Pile of Open Books

Want to see more of the pictures and examples? Check out my Flickr Gallery!

People & Organizations to Follow:

15 librarians to follow on Instagram

@lucasjmaxwell - Twitter- Glenthorne School Library, IG London
Mayfieldlibrarian -High School Library in New Mexico

Libraryatsems - My California Middle Library friend Mary who is amazing!
Librariantiff - Tiffany Whitehead - former mentee & inspiring Librarian
Jennlagarde - former mentee & Teacher. Learner. Rabble Rouser.
Jessamine County Library - These Public Library is on Point!
Tigers_read - Leander Middle School Library - Strong Bookface game!
Readwoke_librarian -Georgia School Librarian

sljournal - School Library Journal

@studentsneedschoollibraries (Australia) It's kind of great.
alia_cys -ALIA Children's and Youth Services

Hashtags to Follow -Yes, you can follow hashtags! Great way to
discover new creative voices & people to follow!
#librariesofinstagram

#schoollibrary
#BookFaceFriday

#Libraryl ife
#TLChat



https://www.thedaringlibrarian.com/2019/01/ig-holiday-highlights-more.html
https://www.thedaringlibrarian.com/2018/02/24-social-media-shortcuts.html
https://www.slideshare.net/gwynethjones/social-media-shortcuts-ataglance-tips-for-educators-87745663
https://www.slideshare.net/gwynethjones
https://www.slideshare.net/gwynethjones
https://www.vulture.com/2018/10/the-terrible-instagram-trend-of-piles-of-open-books.html
https://www.vulture.com/2018/10/the-terrible-instagram-trend-of-piles-of-open-books.html
https://flic.kr/s/aHsmGcokZF
http://oomscholasticblog.com/post/15-librarians-follow-instagram
https://twitter.com/lucasjmaxwell
https://www.instagram.com/glenthorne_library/
https://www.instagram.com/mayfieldlibrarian/
https://www.instagram.com/libraryatsems/
https://www.instagram.com/librariantiff/
https://www.instagram.com/jennlagarde/
https://www.instagram.com/jesspublib/
https://www.instagram.com/tigers_read/
https://www.instagram.com/readwoke_librarian/
https://www.instagram.com/sljournal/
https://www.instagram.com/studentsneedschoollibraries/
https://www.instagram.com/alia_cys/
https://www.instagram.com/explore/tags/librariesofinstagram/
https://www.instagram.com/explore/tags/schoollibrary/
https://www.instagram.com/explore/tags/bookfacefriday/
https://www.instagram.com/explore/tags/LibraryLife/
https://www.instagram.com/explore/tags/TLChat/

#FutureReadyLibs
#ISTELibs

#MakerSpace

Related Hashtags
#librariesfollowlibraries

#nationalreadabookday
#librariansofinstagram

#loveofreading
#internationalliteracyday
#librariesmatter
#kidsliterature
#mediaspecialist
#readingteacher
#childrensliterature

#BookBento

From Jennie Bales, Library Professor in Tasmania: “Bento is a Japanese

term of single serve take away meal that is served in a box — traditionally lacquered wood — with
separate sections for different portions. Applying this structure to a literature response strategy
results in book bento boxes. Here are some great examples to get you inspired. You will see
that the box structure can be somewhat flexible in this strategy and most do not have
compartments for different portions...... An alternative way to express a response to literature
that will excite students with its combination of personal expression, visual arts, technology
(Instagram), creativity and hands on compilation of the bento box contents.”


https://www.instagram.com/explore/tags/futurereadylibs/
https://www.instagram.com/explore/tags/istelibs/
https://www.instagram.com/explore/tags/MakerSpace/
https://www.instagram.com/explore/tags/librariesfollowlibraries/
https://www.instagram.com/explore/tags/nationalreadabookday/
https://www.instagram.com/explore/tags/librariansofinstagram/
https://www.instagram.com/explore/tags/loveofreading/
https://www.instagram.com/explore/tags/internationalliteracyday/
https://www.instagram.com/explore/tags/librariesmatter/
https://www.instagram.com/explore/tags/kidsliterature/
https://www.instagram.com/explore/tags/mediaspecialist/
https://www.instagram.com/explore/tags/readingteacher/
https://www.instagram.com/explore/tags/childrensliterature/
https://jenniebales.wordpress.com/2018/09/24/book-bento-boxes/
https://www.instagram.com/bookbento/?hl=en
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Interactive Book Bento with ThingLink by JennieBales
Building beautiful book bentos — @joycevalenza ...

jennlagarde « Following

jennlagarde My awesome Rulgers
#YAlt students created a #bookbento
as part of a summative assessment to
demonstrate their ability to connect
titkes from this semester's reading list
with a plethora of multi-media
respurces (like book trailers, author
interviews, reviews etc.,) to inspire and
hook readers! What you don't see here
is that they then uploaded these
gorgeous examples to ThingLink whene
they attached them to expertly curated
resources for teachers and students 1o
explore and be inspired by! The results
were epic and I'm so proud of and
delighted by their finished products,
P5: These are just a handful of
examples that | got permission to share
- but they wore all AMAZEballs! #ru548

Qg W

&l Liked by librariantiff and 154 others

Book Bento Box (@bookbento) « Instagram photos and videos

Book Bento Boxes | Jennie Bales


https://www.thinglink.com/scene/1100572072146370562
http://blogs.slj.com/neverendingsearch/2019/05/04/building-beautiful-book-bentos/
https://www.instagram.com/bookbento/?hl=en
https://jenniebales.wordpress.com/2018/09/24/book-bento-boxes/
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2. Favorite Book cover
3. School or Local Library
4. BooK Field TriD (Toke a book somewhere)
5. #Shelfie (You holding a book)
6. BOOK Spine Poem or Message
7. #BOOKFace (Bonus i you dress upl)
8. BOOKS + Pel (Real, stuffed, or imagined)

seasonal Read (Bonus i¢ you decoratel)

{Booksento: (Arrange items around
ok that give i+ more meaning
hout spoilers!)

\") Tag me in your posts!
“ »@TheDaringLibrarian - 16 or on Twitier @GwynethJones

Interactive Instagram Book Challenges:

Instagram Photo Challenge Returns!

31 Days of Instagram Challenge - 5 Minute Librarian

What | Learned From Hosting An Instagram Challenge (+ 6 Tips to Create
Your Own!)

From BookRiot #RiotGrams 2019
“We’ve talked a bit about Bookstagram here on Book Riot, and you
probably know about our own sweet little Instagram account. Now we’d


https://www.ocls.info/ocls-blog/april-instagram-photo-challenge-returns
http://www.5minlib.com/2015/09/31-days-of-instagram-challenge.html
https://www.melyssagriffin.com/hosting-instagram-challenge/
https://www.melyssagriffin.com/hosting-instagram-challenge/
https://bookriot.com/2019/02/01/february-2019-riotgrams/
https://bookriot.com/2016/03/21/bookstagram-like-pro/
https://bookriot.com/2013/06/07/a-brief-guide-to-bookstagram/
https://bookriot.com/2016/06/14/joys-bookstagram-challenges/
https://www.instagram.com/bookriot/

like to challenge the awesome readers and community of Book Rioters to
take part in a month-long Instagram challenge, hosted by us. If you've
got an Instagram account, that’s all you need to take part.”
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1 CURRENT READ

JOIN THE BOOK RIOT BOOKSTAGRAM CHALLENGE

2 LOCAL BOOKSTORE OR LIBRARY
3 FAIRY TALES

4 SHELFIE

5 FALL nennj/‘\

6 NAKED BOOK SPINES

W 7.FuN BOOK DEDICATION

8 FREEBIE!

9 NATIVE AND INDIGENOUS READS
10 MENTAL HEALTH BOOKS

11 FAVORITE FEMALE CHARACTEF
2 CLASSICS YOU LOVE

13 FAVORITE BOOK COVER

14 LIBRARY BOOKS

15 BOOK MORE PEOPLE NEED TO READ

16 ORANGE & PURPLE

17 STACK OF COMICS
18 PAIRA:BOOK & BAND
19 SETTING YOU'VE BEEN T0
20 PUZZLE BOOKS
21 BOOK TEES, TOTES, PINS, & SWAG
22 BOOK THAT MADE. ¥(
J.B00K THAT MADE YOU LAUGH

24 WITCHES & GHOSTS

25 BOOK THAT CHANGED YOUR LIFE
26 BACKLIST/0LD BOOKS THAT ROCK
27 LEAST FAVORITE BOOK COVER

28 BOOK & SOCKS

29 CATS!

30 BOOKS BY/ABOUT CELEBRI

31 BOOKS & CANDY



F(olourMytveryDay
Instagram challenge

\ by @adventuresandteaparties ‘
, Daily Prompts
§ T e e

). Autumn favourite
1. Cosy *
‘ 3. food

4. from the wardrobe ’
9. leaves

6. Spicy
,‘ 1. Moodboard or flatlay ¥ 4

Related: IT'S OK TO D ATE
24 Social Media Shortcuts -

You Don't Have to Marry lt! % "Ew

Heavy social media use affects girls’ > TECHNOLOGY

mental health differently than boys YOU DON'T
What's Up with TikTok?

- HAVE TO
The TikTok Effect l “ARRY IT



https://www.thedaringlibrarian.com/2018/02/24-social-media-shortcuts.html
https://www.thedaringlibrarian.com/2015/04/you-dont-have-to-marry-it.html
https://www.today.com/health/heavy-social-media-use-affects-girls-mental-health-differently-boys-t160683
https://www.today.com/health/heavy-social-media-use-affects-girls-mental-health-differently-boys-t160683
https://www.thedaringlibrarian.com/2019/08/whats-up-with-tiktok.html

What is TikTok? | ABC News - Australia

Helpful Google search

BEGINNERS -

cuETo |IKU
TIK TOK

How to Make Tik Tok Videos — Beginners Guide to Tik Tok 2018

HOW TO USE
TIK TOK

EFFECTS

How to Add Effects to Tik Tok Videos - New Features!



https://youtu.be/mQEGJMmqBTw
https://www.google.com/search?safe=strict&rlz=1C5CHFA_enUS713US715&ei=TqdoXInHCOqL_Qbd5JLIBw&q=why+should+you+have+a+professional+instagram+for+education&oq=why+should+you+have+a+professional+instagram+for+education&gs_l=psy-ab.3...18036.19711..20097...0.0..0.151.1451.9j5......0....1..gws-wiz.......0i71j33i299j33i160j33i22i29i30.f-w8jCHLxqw
https://www.youtube.com/watch?v=apoVa0gwER8
https://www.youtube.com/watch?v=apoVa0gwER8
https://www.youtube.com/watch?v=apoVa0gwER8
https://www.youtube.com/watch?v=pelOhT_sF-8
https://www.youtube.com/watch?v=pelOhT_sF-8
https://www.youtube.com/watch?v=pelOhT_sF-8
https://www.youtube.com/watch?v=apoVa0gwER8

Use keywords that describe your brand.

Those keywords
are the only
searchable
keywords on
IG. By default
Instagram

fills in your
name but

you can

change it.

+© lover
+ Find Yo Bo +
VA KT nibrause comifind -your-tribe

If you have
space, write
something
personal about
you, like
‘almond latte
lover’ or use
an emoji to
describe a
feeling,

your favorite
food or pet
{mine are
doughnut,
palmtrees and
pink, of course)

aaas of-de T 13:22 o .
+S - kristinbrause v 19
G 10 876 538

¥
!‘ Edit Profile

Kickass Instagram Brand Tips
o | @ brands & Instagram
1 : _ ﬂ Tell your
#= Teaching femtreprenaurs how to build a i
KICKASS brand audience the

value they
get from your

=4 FOLLOW ME FOR DAILY BRAND TIPS

r Tribe aBook 3 aCCﬂ‘Hﬂt;
value-sweel-spot-formula S{.rﬂ;ght away-
Ty
’ 1- quﬂi: st
What do you
want your
. audience
' C = :-_'i\, to do next?
¥ L '-'=/
a0
-
—

To promote

your latest

project, your

opt-in offer, what is
your ‘Champagne’ that
you offer new visitors?

KristinBrause.com



Got Questions?

Didn’t find what you were looking for? Why not try to Google
your topic plus Daring Librarian, | might have already blogged
about it. Still no joy? Tweet, Instagram, or email me at
gwynethanne AT @ gmail dot com, I'm happy to help! Contact
& About Me

CANVAS Page Link for Webinar



https://vimsy.co/blog/how-i-learned-to-stop-worrying-and-love-instagram-stories
https://www.schoolwebmasters.com/Blog_Articles?entityid=375224
https://twitter.com/GwynethJones
https://www.instagram.com/thedaringlibrarian/?hl=en
https://www.thedaringlibrarian.com/p/daring.html
http://www.daringlibrarian.com/portfolio/About%20Me.html
https://canvas.emporia.edu/courses/34516/pages/webinar-resource-sheet
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